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Linear Raw Profiles 

In this lesson, we’re going to dive into Linear Raw Profiles. When you open a RAW 
file in Camera Raw or Lightroom, a lot of things happen behind the scenes that are 
not revealed to you. When an image is opened, it is automatically brightened and 
contrast is added to the dark portion of the image. This is fine if a large portion of 
the image is dark. However, if the image contains a lot of bright information or if 
you have issues with the bright part of the picture, this initial adjustment (in the 
form of a tone curve) will not be helping your image. There is a way that we can 
trick Lightroom or Camera Raw into NOT applying this curve that is otherwise 
always applied. We do that by creating a linear profile. A linear profile will tell 
Lightroom (or ACR) to not apply this curve. Here, you’re going to learn how linear 
profiles work, how you can create them and when might you want to use them.

How Linear Profiles Work (Timestamp 1:35)

When an image is opened in Lightroom or Camera Raw, its tone curve is adjusted 
automatically, by default. Let’s look at the curve chart. In a standard curve chart, 
black is represented on the left side and white is represented on the right side. 
All of the shades of gray can be found in between. The diagonal curve line shows 
how much light is needed to create those various shades of gray. On the left side, 
the line is positioned at the very bottom of the chart. This is because it takes no 
light to create black. As you move to the right, the line gets higher and higher, 
creating the lighter shades of gray. On the right side of the chart, the line is at the 
very top because it takes the maximum amount of light to create white. 

This straight line is what the curve looks 
like when no changes have been made 
to the picture. When an image is opened 
in Lightroom or Camera Raw, the line 
will be automatically moved to create 
an upward curve, adding light and con-
trast to the image. (See screen shot) 

BLACK LINE: The 
default position 
of the curve.  

RED LINE:  
The automatic  
adjustment made 
to every raw  
image
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If you compare the original curve line to a series of dimmer switches, the dimmer 
switch would be originally positioned wherever that diagonal line is. If you were 
to move the line up, you would brighten the image by adding more light. The 
farther up you move the line, the greater change you’ll be making to the image. 

When part of the line is moved up, the left and right points will be anchored in 
place. That’s why the line turns into a curve. In the areas where the curve line 
is farthest from the original straight line, the image will be receiving the largest 
change. There will be less of a change in the areas where the line is closer to its 
original position. 

Contrast The term contrast refers to how big of a difference there is between the 
various shades in the picture. After adjusting a curve line, the steeper parts of the 
curve (closer to vertical) are where more contrast is being added to the image. 
The steeper the curve, the more contrast is being applied. Looking at the curve 
that Lightroom and Camera Raw automatically apply to the picture, you can see 
that the curve is steeper on the left side, which represents the darker areas. This 
means that more contrast is being added to the darker parts of the picture. The 
right side of the curve is not as steep as its original diagonal position. That means 
the contrast will be decreased in the bright areas.

Curve is not as steep as default 
line (black) = Less contrast

Curve is steeper than default 
line = More contrast
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I do not believe that this automatic curve adjustment (that is applied to every 
image) is always helpful. I find that it can actually be detrimental to images that 
have a lot of bright areas. If you look at the histogram for an image and find that 
most of the histogram bars are located on the right side of the chart, it means 
that most of the image is bright and that this automatic adjustment is probably 
not being useful. 

NOTE: If there is a tall spike on the far right side of the histogram, it means that 
there are areas in the image that are solid white. Changing the profile to linear 
will have less of an effect on these areas. It will, however, improve the look of the 
content directly surrounding the solid white areas. 

The default curve adjustment was 
made to this image, which contains a 
lot of bright areas.

A linear profile was applied to the 
image, removing that default  
adjustment.
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A linear profile is named as such because the curve line is never moved. It remains 
in that default, straight diagonal line. When the line is moved, it creates a curve 
and is therefore no longer “linear.”

After opening an image in Lightroom or Cam-
era Raw, you can change to a linear profile 
by clicking on the Profile menu (in the Ba-
sic Panel) and clicking on the Profile menu. 
Here, one of the options will be Linear *cam-
era name*. If you apply this to overly bright 
images, it will likely give you a better starting 
point for making adjustments. For that rea-
son, it’s best to change the profile right after 
opening the image. If you changed the pro-
file after making some adjustments, it could 
change the image such that you’d need to 
update those adjustments. 

LEFT: The default curve adjustment was made to this image. RIGHT: A linear profile was ap-
plied. This improves most of the bright areas, with the exception of the areas that were blown 
out to white. Those areas are represented by the spike on the right side of the histogram.

After you have created a linear profile, it  
will appear in the Profile menu within the  
Basic Panel.
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Linear profiles for darker images The linear profile should not be strictly limited 
to images that are mostly bright. There may be instances where you have an im-
age that is mostly dark, but it’s the smaller bright areas that are really causing a 
problem. The Golden Gate Bridge image is a good example. It was shot at night, 
so most of the image is dark, but the bright lights on the surface of the bridge 
are too bright and are therefore losing detail. When we switch to a linear profile, 
those bright areas look much better. You will of course need to continue making 
adjustments to compensate for the dulling effect the profile may have had. 

Linear profiles for older files I mentioned that it’s a good idea to change the 
profile immediately after opening the image. That IS ideal, but what if you want 
to rework an older file that you had already adjusted in the past? You can abso-
lutely change the profile on an image that you already worked on. In fact, I will 
often times open older files and look for new ways to optimize them. The linear 
profile setting may be just what the image needs if the bright areas are so bright 
that they’re losing detail. Just know that you will likely need to re-adjust the other 
tonal sliders as well in order to compensate for the change. 

LEFT: Before the linear profile was applied. RIGHT: After the linear profile was applied.

Here you can see an older 
image that I revisited. A 
linear profile was applied 
to the version on the right 
and you can see that it 
brought more detail into 
that bright flower petal.
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How to Make a Linear Profile (13:37)

DNG Profile Editor In order to create a linear profile, you will need to down load 
the DNG Profile Editor utility. This is a free utility from Adobe, and you can down-
load it here: https://helpx.adobe.com/camera-raw/digital-negative.html

You will need to feed the utility a DNG file that was produced from the model of 
camera you plan on using.

Filter to find cameras used in catalog  If you use multiple cameras, you will need 
a separate profile for each camera. You can see what cameras were used to gen-
erate all of your images by using the Filter Bar in Lightroom’s Library Module. In 
the Library Module, expand the Catalog Panel on the left side of the screen and 
click on the “All Photographs” option. This will display a thumbnail list of every 
single image in your catalog. You can filter these images by expanding the Filter 
Bar above the main image window. Select the Metadata filter option and then 
set the left-most menu to Camera. This will show a list of all the cameras used to 
create the images in your catalog. 

Prepare RAW file for DNG utility You’ll need to find a RAW file for each of the 
cameras you’d like to create a profile for. Activate a RAW file (a JPEG won’t work) 
and open it in Lightroom’s Develop Module. If the image has been previously ad-
justed, set it back to default settings by clicking the Reset button in the bottom 
right corner. Then expand the Basic Panel and make sure that the Profile menu is 
set to Adobe Standard. The file is now prepared to be sent over to the utility to 
create a linear profile. 

In the Library Module, the Catalog is set to show All Photographs. We chose to filter by  
Metadata and then set the left menu to Camera. This shows all of the cameras that were used 
in the current catalog.

https://helpx.adobe.com/camera-raw/digital-negative.html 
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The image needs to be exported out of Lightroom as a DNG file. To do this, click 
on the File menu and choose Export with Preset > Export to DNG. Save the file in 
a place that you’ll remember. 

Open the DNG Profile Editor Utility, click on the File menu and choose Open DNG 
Image. You’ll be prompted to navigate to the DNG file that you just saved. Click 
Open and the image will appear alongside a settings dialog. This dialog remem-
bers any settings that were previously used, so I always make a habit of first click-
ing on the Edit menu and choosing to Clear All Adjustments. This just ensures 
that you’re starting with default settings. 

In the settings dialog, activate the Tone Curve tab and set the Base Tone Curve 
menu to Linear. This will ensure that no curve adjustment is applied to the image 
when it’s opened. Next, click on the Options tab and type “Linear Profile” or “Lin-
ear Curve” into the Profile Name text field. Now you can click on the File menu 
and choose Export. The Export dialog will open and it will have already navigated 
to the appropriate location on your hard drive. Make sure that you save the pro-
file in this location. It will have added the name of your camera to the file name, 
which is what you want. Click the Save button. You can now close the image file 
and repeat the process with DNG images from any additional cameras from your 
catalog. Now that you’ve saved your linear profiles, you will need to restart Light-
room in order for them to appear in the Profile menu. 

In the DNG Profile Editor, the dng file is open and the Base Tone Curve menu is set to Linear.
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Apply a profile Open an image in the Develop 
Module and expand the Basic Panel. The Profile 
setting appears at the top of the panel. Expand 
the Profile Browser by clicking on the icon to the 
right of the profile menu        or by clicking on the 
Profile menu and choosing Browse. Inside the Pro-
file Browser, the profiles you saved will be locat-
ed in the category that’s simply called “Profiles.” 
Note that these profiles are camera-specific, so 
you will only see the profile[s] that were created 
for the specific camera that was used to shoot the 
active image. Click the profile thumbnail to apply 
it to your image. If you click the little star icon in 
the corner of the profile thumbnail, it will add it to 
the favorites list so that it appears inside the Pro-
file menu at the top of the Basic Panel. 

How to Implement Profiles & Optimize Images (24:54)

Now that you know how to create and apply a linear profile, let’s take things a 
step further and learn how to use them to best optimize your images. Right after 
a linear profile is applied, the image will likely look a bit dull. That’s ok, because it’s 
really just designed to serve as a good starting point. You’ll need to make further 
adjustments to add pop and optimize the image. 

Auto adjust There is an Auto button inside the Tone cate-
gory of sliders within the Basic Panel. When you click this 
button, Lightroom (or Camera Raw) will evaluate the image 
and adjust the total sliders automatically. This is always an 
option, but know that this can commonly result in blown out 
highlights. That’s because it doesn’t know that a linear pro-
file has been applied. If you choose to use the Auto setting 
(and it will vary from image to image), keep in mind that you may need to then 
lower the Highlights slider in order to compensate for those bright highlights. 
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The Tone Curve The Tone Curve Panel is lo-
cated directly below the Basic Panel and it’s 
a great option for adjusting an image with a 
linear profile applied. Inside the Tone Curve 
Panel, some curve options appear above 
the chart. I like to use the second option, 
which is the point curve. This curve allows 
you to add points and manually move them 
in order to adjust the tones in the image. 

A linear profile can make an image look dull 
because it’s lacking contrast in many areas. 
A curves adjustment can be used to add 
contrast back in. To add contrast, you can 
make the dark areas darker, you could make 
the bright areas brighter, or both. 

In the example image, there are snowy 
mountains in the distance that look quite 
dull and could use more contrast. The bright 
areas are already quite bright, so we’ll add 
contrast by making the dark areas darker. 

The version on the right has a linear profile applied and you can see that the image looks dull.

The Tone Curve Panel. The point curve 
option (circled) is active.
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With the point curve active, activate the Targeted Adjustment Tool        , which ap-
pears in the top left corner of the panel. This tool allows you to click on the image 
to target specific tones in the image. When you click on the image, a point will be 
placed on the curve. That point represents the specific tone you clicked on. 

Use the Targeted Adjustment Tool to click on the brightest area within the part 
of the image that needs contrast. In the lesson example, it’s the bright snow on 
the mountain. You’ll see a point appear on the curve, representing that tone. 
This point will stay in place on the curve, ensuring those bright tones won’t be 
changed by additional curve points. 

Then, use the Targeted Adjustment Tool to click and drag down on the dark area 
within the part of the picture that needs contrast. This will place a second point 
on the curve and move it down, darkening that targeted tone. The farther down 
you drag, the darker the area will become. 

Adjust results using masks This will improve the contrast in the area you were 
targeting, but other parts of the image may be adversely affected by the ad-
justment. In the lesson example, the mountains look much better, but the darker 
foreground has become too dark. 

Two points were placed on the curve. The upper point is locking the bright areas in place. 
The lower point was moved down, darkening those darker tones. 
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Lightroom’s masking feature can be used to cor-
rect this. The masking icon can be found in the 
toolbar above the Basic Panel. When you click it, 
several masking options appear. The best choice 
will vary from image to image. In the lesson ex-
ample, we want to correct everything except for 
the sky and mountains, and the Select Sky option 
worked well to isolate this area. After choosing 
the Select Sky option, we turned on the Invert 
check box so that everything EXCEPT the sky 
was selected. A colored overlay will appear over 
the area being masked. 

After you have created a mask to target the area you need to correct, you can 
use the adjustment sliders on the right. As soon as you move a slider, the overlay 
will disappear so that you can see how the adjustment is affecting the image. If 
you’re trying to lighten an area that became too dark, try increasing the Shadows 
slider. That did a great job in the example image.  

The masking icon was chosen & 
the list of mask options appears.

A Select Sky mask was created and that mask was inverted. The colored overlay appears 
over the area being isolated. 
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You can also make the area pop by increasing the Whites slider. This makes the 
bright areas lighter while leaving the dark areas alone. The histogram is a good 
indicator of whether the Whites slider may be useful. If there is a large gap on 
the right side of the histogram, it means that there are no white areas. Therefore, 
increasing the Whites slider will fix that. 

The sliders in the HSL Panel can be used to adjust individual colors, if needed. 
I felt that the blue water was too colorful, so I moved the blue Saturation slider 
down. This did not affect the blue sky because that area is not isolated by the 
mask. 

When to Use Linear Profiles (36:19)

Linear profiles can be a useful starting point for images with a lot of bright areas, 
but they are not always necessary. In fact, there are other adjustments that may 
do a better job at optimizing some of these types of images. Let’s look at how 
you can tell if an image will benefit from a linear profile or if a different adjustment 
should be used instead. 

With the foreground isolated with the mask, the Shadows slider was increased and the 
Whites slider was increased.
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Open an image in Lightroom’s Develop Module and activate the before and after 
view, which can be accessed by clicking the Y|Y icon        below the image win-
dow. This will show a before version on the left and an after version on the right. 
Set the After version to use the linear profile. Then, swap the two versions by 
clicking the Swap icon        below the image window. This places the linear profile 
image on the left, as the before version. Now the adjustment settings will affect 
the other version. 

Now you can try to optimize the image without using the linear profile. You can 
experiment with lowering the Exposure slider if the image is too bright. In the 
lesson example, that did a really nice job. 

The Blacks slider can also be useful if you need to add a black point. You can tell 
if there are no blacks in the image if the histogram has a gap on the left side. The 
Dehaze slider can also do a great job at making the dark areas pop more. Just 
know that it’s easy to go overboard with this setting. You will be able to push this 
slider further when working on the linear adjustment image. 

The linear profile was applied to the version on the left and the Exposure was lowered on 
the version on the right.
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Continue swapping the two versions and making adjustments to each. This will 
give you a good idea of whether or not the linear profile was beneficial. The view 
that’s on the right (After) is the version you’re going to end up with. Exit the be-
fore and after view by clicking the left-most icon below the image window. 

If you’d like to save both versions, you can 
use Snapshots. Expand the Snapshots Panel 
on the left side of the Develop Module. Click 
the Plus icon ( + ) at the top of the panel to 
create a new Snapshot of the After version. 
Then, swap the versions and create a second 
Snapshot. If you ever make changes to one of 
those images and want to update the Snap-
shot, you can do so by right-clicking on the 
name of the Snapshot and choosing Update 
with Current Settings from the pop-up menu.


